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Preface 
 

Signal, along with a 1401 

interface and 1902 

amplifier, offers a complete 

solution for evoked response 

recording when used in 

conjunction with the 

Magstim range of 

transcranial magnetic 

stimulators. 
 
Signal is a sweep-based data capture and analysis software 

package. It provides direct control of Magstim stimulator 

parameters during sampling, including adjustment of stimulus 

intensity and trigger timing. This guide is intended to help you 

setup a TMS system for evoked potential recording using Signal, a 

1401 interface, a 1902 amplifier and a Magstim stimulator.  

 

Requirements: Signal for Windows 

version 3.08 or higher, Power1401 or 

micro1401 laboratory interface, 

Magstim 2002, BiStim2, Rapid2, Super 

Rapid2 or Super Rapid2 Plus stimulator. 

 

Optional:  CED 1902 amplifier or other 

software-controllable amplifier (e.g. 

Digitimer D360), Electrode adaptor box, USB to serial adaptor. 
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Software installation 
 

Install the Signal software from the supplied CD. There are a number of 

options given during the installation process and the following steps should be 

followed to ensure the correct features are installed. After setting the 

installation directory, your name and organisation and selecting Compact, 

Custom or Typical setup, the following page will appear. 
 

Signal conditioner support 
This option is to install software 

support for a signal conditioner.  If 

you are using a CED 1902 amplifier, 

select CED 1902 signal conditioner 

and click Next. Information on setting 

up a 1902 amplifier for recording 

can be found in the  

1902 amplifier setup section. 
 
 

If using a Digitimer D360 amplifier select the Digitimer D360 signal 

conditioner option. This device connects with a USB to serial interface which is 

automatically selected 

 
The CED 1902 amplifier is 

controlled via a COM port 

(RS232). Many desktop PC's will 

have at least one COM port 

available (usually COM1). For 

laptops and PCs without an 

available COM port, a USB to 

serial adaptor can be used 

instead. This should be plugged in 

to an available USB port before 

continuing.  
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If you know the COM port you want to use, select it here and click Next. If 

you are not yet sure which port you want to use you can check for available 

COM ports as described below, or select COM1 at this stage and then simply 

change the 1902 COM port in the Edit menu Preferences > Conditioner 

section in Signal later on.  
 
 

Check for available COM ports 
All available COM ports are listed in the 

Windows Device Manager. The quickest way to 

open the Device Manager on any version of 

Windows is to use the Windows key + R 

keyboard shortcut to open the Run command, 

enter devmgmt.msc in the dialog and Click OK. 

 
You can also open the Run command from the 

Start menu in Windows XP. In Windows 7 you 

can access the Device Manager from the 

Control Panel in the Start menu or open the 

Run command from the All Programs > 

Accessories folder in the Start menu. 

 
In the list of hardware devices should be an entry for Ports (COM & LPT). 

Click on this to show the available ports. You can edit the COM number 

assigned to a port for most devices by double-clicking on the entry. Click on 

the Port Settings tab and then the Advanced... button. You can set the COM 

port number from a drop-down list.  
 
 
The following two installation options are for the inclusion of telegraph 

support and patch and voltage clamp features within Signal. These are 

specialised features for electrophysiology research so click Next to accept the 

default settings if you do not need these options. 
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Magstim support 
Select the Magstim auxiliary state support option if the model of your 

stimulator is a 2002, BiStim2, Rapid2, Super Rapid2 or Super Rapid2 Plus, 

otherwise select No auxiliary state hardware support. You can use Signal to 

generate output pulses and trigger older Magstim models, but only those 

models in the xxx2 range can be fully configured and controlled using the 

auxiliary states system. Magnetic stimulators from other manufacturers are 

also available, but these are usually only able to accept trigger inputs. 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

Continue the installation accepting the default options by clicking Next until 

the installation completes. 
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The 1401 interface 
Confidence check 
The device drivers for the Micro1401 and Power1401 interfaces are installed 

automatically along with Signal. Once the Signal installation has completed, 

connect the 1401 power brick to the DC Power port on the rear of the unit 

and plug in to a mains outlet. Connect the 1401 to your PC using the 

supplied USB cable and switch it on. Windows will detect the 1401 and 

automatically display a message stating that it is looking for the driver. Once 

it has found the CED1401 driver and installed it the message will disappear. 
 

Self-test 
The first and easiest check to perform is to run the 1401 standalone self-test, 

which runs automatically when the 1401 is switched on. Remove the USB 

connection from the 1401 and all other connections from the front and rear 

panels. Once all connections have been removed, power up the 1401. The 

self–test will then run with the main switch LED lighting up red and the 

LED’s on the front panel flashing in sequence. Once the self-test completes the 

LED should turn blue (Micro1401) or green (Power1401) if all is well. If the 

1401 passes this test, but shows a fault during use while connected to the PC 

or other devices, it is likely that the fault lies in the host computer hardware 

or software. 
 

Try1401 
If the LED on the 1401 continues to flash red, then the standalone self-test 

has detected a problem. A 1401 diagnostic program, Try1401 is installed 

along with Signal and can be used to provide details of the problem. Re-

connect the 1401 to the host PC with the USB cable and open the Try1401 

program, which can be found in the Signal folder and accessed from the Start 

menu. 

From the File menu in the Try1401 program select 1401 info… which will 

return information about the 1401 hardware and installed firmware. If 

Try1401 returns an error at this stage refer to the Troubleshooting guide in 

your 1401 manual or contact CED for assistance. 
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If the 1401 info… returns a list of information, then communication is fine 

and you can proceed with the Try1401 tests. Check the Self test option in the 

main toolbar and click Run once. This performs a series of tests on the 1401 

and reports the results. If no errors are detected at this stage it is worth 

selecting the Run cont option to try and pick up any intermittent faults. You 

should then inform CED of any errors: The Send email option from the File 

menu will create a new email, with the Try1401 report as an attachment 

that can be sent to hardhelp@ced.co.uk 

 

If the main LED on the 1401 remains red, but does not flash, you should 

contact CED directly for help either by phone or email at hardhelp@ced.co.uk.  
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Hardware configuration 
 
The connection diagram below shows a common hardware configuration for 

TMS recording. This includes a single 1902 amplifier connected to the PC via 

a serial line with a dual USB to serial adaptor along with a Micro1401-3 and 

Magstim Rapid2. The Magstim connects to the PC using the second serial-line 

input on the USB to serial adaptor.  
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In the diagram above the CED 1902 is fitted with an input clamp option, 

which can be used to suppress the artefact that occurs after stimulation. This 

is generally only required with very fast responses (i.e. 2-10ms after 

stimulation), or if recordings are taken close to the site of stimulation. The 

input clamp is triggered with an input to the Trigger 2 port on the 1902 as 

shown. See 1902 amplifier setup for further details. 

 

Signal sampling configuration 
 
All settings for sampling data, 1902 

amplifier control and Magstim 

control are set-up within a sampling 

configuration in Signal. The 

downloadable configuration file, 

MagstimExample.SGC, contains 

example settings that you can use to 

generate output pulses to trigger a 

Magstim and record the response 

data. Open Signal and load the 

MagstimExample.SGC file from the 

Load sampling configuration option 

in the File menu. 
 

1902 amplifier setup 
 
The following section describes how to setup a CED1902 amplifier for evoked 

potential recording. If you are using a third-party amplifier that is not 

software controlled you can skip directly to Magstim setup. 

 
With mains power off, connect the power brick and included RS232 serial 

cable to the rear of the 1902. Connect the power brick to a power outlet and 

the RS232 cable to an available COM port on the host PC or to the USB-

serial adaptor that you connected to an available USB port on the host 
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computer during installation of the Signal software. Switch on the mains 

outlet to power up the 1902. Once the green Power LED is lit, the 1902 is 

ready for use. 

 
If 1902 conditioner support was selected during the installation, Signal 

provides complete control over the 1902 amplifier settings via a control panel 

which can be used to adjust amplifier gain and offset, modify filter settings 

and enable triggering and clamp duration if the 1902 has been fitted with 

the input clamp option. By default, the control software expects each 1902 

channel to be connected to the corresponding ADC port number on the 1401 

interface using a BNC cable, which you should connect now. This example uses 

a single 1902, channel 0, which is connected to ADC 0. 

 

Remember that, although the hardware port connections start with channel 

0, channel numbers in Signal data files always begin at 1  
 

The 1902 control panel is available from the Port setup tab of the Signal 

sampling configuration. If you select an ADC port in the list, and there is a 

corresponding 1902 attached, the CED 1902 button is enabled. Click on this 

to open the 1902 controls. To the right of the main control panel is an 

oscilloscope window which shows incoming data for the currently selected 

1902. The control panel can also be accessed during sampling by selecting 

Signal conditioner... from the Sample menu. 
 
 

If Signal fails to detect the 1902, check that the COM port settings in Signal 

match the COM port that the 1902 is connected to. You set the COM port to 

use in Signal from the Edit Preferences menu Conditioner tab. To check which 

COM port the 1902 is connected to, see Check for available COM ports above. 
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The Port list shows the current 1902 channel and the Input drop down list 

sets the input mode for the selected 1902. With an input clamp the list will 

display EEG unclamped and will also contain a list of times in milliseconds. 

These specify the length of time to apply the input clamp in response to a 

pulse input on the Trigger 2 port of the 1902. If the clamp option is not 

fitted you should set the input to use Isolated EEG. 
 

The Gain and Offset controls are used to scale the incoming data. The Filter 

settings are used to apply input filtering as required.  
 

The EEG unclamped, clamp duration settings and Isolated EEG options all use 

the isolated stage of the amplifier and are the only inputs suitable for 

recording responses from surface electrodes. 
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Triggering the input clamp 

 
 

Stimulus artefacts can often saturate the input of an amplifier, causing a 

period of ‘lost’ recording while the amplifier input returns to a normal level. 

This can cause problems if the response is very fast or is being recorded from 

close to the site of stimulation. The diagram above shows a fast MEP response 

from the electrode (Fig. A) that is missed due to the amplifier saturation 

caused by the stimulus artefact (Fig. B). 
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The CED 1902 amplifier can be fitted with an input clamp option that 

suppresses the artefact by clamping the amplifier input to ground during 

stimulation. This prevents saturation of the amplifier input, allowing fast 

responses to be recorded (Fig. C). 

 

The input clamp should be triggered marginally before the Magstim to ensure 

that the clamp circuit is fully engaged before the stimulus is applied, as in the 

above diagram. One way to achieve this is to use a single pulse output of 0.5 

to 1ms duration and route this to both the trigger input of the Magstim and 

the Trigger 2 input using a T-piece. The same pulse can then trigger the 

1902 clamp with the rising edge of the pulse and the Magstim with the 

falling edge, ensuring the necessary delay. Alternatively you can set up a 

second pulse on another digital output to trigger the 1902 clamp circuit 

separately from the Magstim. See setting up output triggers for further 

details. 
 
 

When using the input clamp, you should turn off the AC couple option and set 

the 1902 high-pass filter setting to None. 
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Magstim control setup  
 
The General tab of the sampling 

configuration is used to set the sweep 

mode, number of channels to record 

and sample rate, as well as various 

options for recording marker channels, 

saving data and triggering sampling. To 

allow access to the Magstim settings, 

the Multiple frame states checkbox must 

be selected. This enables the States tab 

in the dialog where we can specify 

multiple states (stimulus protocols) and 

set-up the intensity and timing settings 

for the Magstim unit.  
 

 
 

In the States tab the State variation 

is set to Dynamic outputs. The 

Number of extra states field is used 

to set the number of different 

intensity and trigger settings you 

want to specify for the Magstim. 

These extra states are in addition to 

the basic state 0, which gives manual 

control by default.  
 

 
 
For example, consider an experiment where you would like to apply two 

different stimuli, one at low power intensity and one at high power intensity. 

Setting the Number of extra states field to 2, as in this example, will allow 

you to set-up two additional stimulus settings in the Magstim configuration. 

In this case we use one for 20% intensity and one for 70% intensity.  
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States can be set-up to cycle automatically during an experiment in numeric, 

random or semi-random order, or by following a sequence of steps defined by 

a protocol. For this example we have set-up numeric ordering. 
 
 

 
Click on the Magstim... button to configure the 

type of Magstim to use and a COM port for 

communication with the unit. See Check for 

available COM ports for more details. 
 

If you are using a CED 1902 amplifier you should 

make sure that the Magstim is set to use a 

different COM port. 
 

The list of states in use is displayed and can be 

edited by clicking on them in the list and then 

changing the settings in the dialog. Depending on 

the type of Magstim selected, you will be able to 

change power intensity, number of pulses and 

pulse intervals. 
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Magstim control options by model 
The table below lists all currently supported Magstim magnetic stimulators 

and the control options available for each model when using Signal and a 

1401 interface. 
 
 

Magstim   200* BiStim*   2002 BiStim2 Rapid2 Super 
Rapid2 

Super 
Rapid2 
Plus 

Trigger 
input 

       
Power 
Intensity 
setting 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Pulse 
Intervals        
Pulse 
frequency        
Single pulse 
mode        
 
*Denotes older Magstim 200 and BiStim units without power intensity control options 
 

Magstim 200 and BiStim units without external control 
Older Magstim 200 and BiStim units can only react to pulse outputs in Signal 

for stimulus timing. See Setting up output triggers for further details. Power 

intensity settings and pulse intervals are set using the front panel controls on 

the Magstim unit.  
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Magstim 2002 Settings 
This configuration shows the available settings for 

a single Magstim 2002 device.  Power settings for 

each control state can be edited by double clicking 

the State number in the displayed list. State 0 

can be set to give manual control of the Magstim 

device using the separate Settings for state 0 

checkbox. 

 

The Dual Magstim 2002 option has the same 

settings as described here but requires two COM 

ports, one for each 2002 unit. 
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Magstim BiStim2 settings 
BiStim units are comprised of two synchronised stimulators which can be used 

to deliver dual stimulus pulses. Normally the first pulse is delivered at the time 

of the external trigger and the second at a preset interval after the trigger, 

which can be set in the state settings of the Magstim configuration as 

displayed.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Setting an interval of Zero switches the BiStim into simultaneous pulse mode. 

In this mode both stimulators must use the same power level, which is taken 

as being the main Power setting in the configuration, with the power b 

setting ignored. 

 

The Use Hi-res timing mode option can be used to set interval values between 

Zero and 999 milliseconds with a resolution of 1 millisecond. 
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Using a BiStim2 in independent trigger (IBT) mode 
It is possible to use two digital output pulses to trigger both the first (Power) 

and second (Power B) stimulus. To use this method the unit must be set to use 

independent trigger mode (IBT mode) using the following controls on the 

BiStim front panel: Set the master BiStim user interface to Simultaneous 

Discharge, with an interpulse spacing of 0. Then hold down the UI stop button 

and rotate the power level knob anti-clockwise. The display on the bottom 

device should then show “E” to signify IBT mode. 

 
When IBT mode has been set on the BiStim unit, The BiStim in independent 

trigger mode checkbox also needs to be selected in the Magstim configuration 

in Signal. This mode requires separate digital output connections from the 

1401 to each of the synchronised units in the BiStim device.  
 
 
When using independent trigger mode with different power intensity settings, 

DO NOT setup pulse outputs to trigger the units with an interval of less than 

1ms  
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Magstim Rapid2 settings 
Magstim Rapid devices are capable of 

producing a train of stimulus pulses at high 

rates. The Rapid may have a separate control 

system that has to be disconnected to gain 

access to the serial line control port for 

connection to a PC. See your Rapid device 

documentation for details. 
 

You can set the intensity, number and 

frequency of pulses in the settings section of 

the configuration. There is also a checkbox 

option to use single-pulse mode which allows 

power levels up to 110%. If this option is 

selected, the Rapid produces one stimulus 

pulse per trigger, ignoring the pulse train 

parameters. 
 
 
 
 
The Ignore coil interlock switch option disables the switch on the Magstim coil 

handle so that the device will fire in response to triggers without the button 

being depressed. Magstim do not recommend bypassing the switch as this is a 

safety feature and should not be used unless absolutely necessary. Rapid devices 

with the latest version 9 firmware require an unlock code, as an additional 

safety precaution. The unlock code for these devices can be obtained by 

contacting Magstim.  
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Setting up output triggers 
 
The final requirement is to set up 

pulse outputs for each state that can 

then be used to trigger the Magstim 

to deliver the stimulus for the given 

state. Pulse outputs are created in 

the Outputs tab of the sampling 

configuration. This section contains 

settings for enabling and disabling 

digital and DAC outputs. For this 

example of Magstim control we are 

only interested in using one digital 

output. Click on Configure pulses to 

open the graphical pulse editor. 
 

If using a BiStim2 in IBT mode you will need to enable two digital outputs, one 

to trigger each of the units of the BiStim2 
 

Example pulse outputs to trigger a Magstim device 
The graphical pulse editor shows the selected outputs as ‘tracks’ in the area at 

the top of the dialog. The thicker blue track is the control track which is used 

to set frame intervals when using other sweep modes. A pulse palette is 

available in the bottom left hand corner of the configuration from which 

pulses can be dragged onto any of the available output tracks.  
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Each of the states that we specified earlier in the Magstim configuration can 

have a different set of pulses configured, allowing multiple stimulus protocols 

to be arranged and used throughout an experiment. There is a drop-down list 

at the top of the dialog from which you can select the state to configure. 
 
 

In our example configuration the Basic 0 state is left blank, as this is going to 

be our manual control state with no output triggers. State 1 and State 2 each 

have a trigger pulse set at 10ms. This will trigger the Magstim at 10ms into 

the sampled sweep and generate a pulse at 20% intensity for State 1 and 

70% intensity for State 2, as we have previously specified in the Magstim 

configuration. Click OK to close the pulse configuration and return to the 

sampling configuration.  
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Sampling data 
 
From the sampling configuration, click Run now to start a new data file ready 

for sampling. As well as a toolbar for starting and stopping sampling you will 

also see the Multiple states toolbar, as displayed below. During sampling this 

shows the current state and has controls for starting and pausing state cycling 

as well as options for manual selection of the current state. 

 
 

Click Start in the sampling toolbar to begin sampling data. The default output 

and control state is set to Basic 0 when sampling starts. You can select the 

current output state using the toolbar buttons or the drop-down list to apply 

each state manually, or click Cycle to apply the states in numeric order as 

specified in the States tab of this example sampling configuration. State 1 and 

State 2 will set power intensity values of 20% and 70% respectively and will 

generate output pulses at the start of sampled sweeps to trigger the Magstim. 
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